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This guide describes how to install, configure, and use Adapter for Apache Cassandra. It provides
an overview of how Apache Cassandra operates and explains common tasks you can perform
using Adapter for Apache Cassandra.

To use this guide effectively, you should be familiar with:

Other software applications and protocols you can use with Apache Cassandra.

The setup and operation of webMethods Integration Server.

Have a general idea about how to perform basic tasks with Software AG Designer.

Document Conventions

DescriptionConvention

Identifies elements on a screen.Bold

Identifies service names and locations in the format folder.subfolder.service, APIs,
Java classes, methods, properties.

Narrowfont

Identifies:Italic

Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Identifies:Monospace font

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the
information inside the curly braces. Do not type the { } symbols.

{ }

Separates two mutually exclusive choices in a syntax line. Type one of these
choices. Do not type the | symbol.

|

Indicates one or more options. Type only the information inside the square
brackets. Do not type the [ ] symbols.

[ ]

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

...
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Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://
documentation.softwareag.com.

In addition, you can also access the cloudproduct documentation via https://www.softwareag.cloud.
Navigate to the desired product and then, depending on your solution, go to “Developer Center”,
“User Center” or “Documentation”.

Product Training

You can find helpful product training material on our Learning Portal at https://
knowledge.softwareag.com.

Tech Community

You can collaborate with Software AG experts on our Tech Community website at https://
techcommunity.softwareag.com. From here you can, for example:

Browse through our vast knowledge base.

Ask questions and find answers in our discussion forums.

Get the latest Software AG news and announcements.

Explore our communities.

Go to our public GitHub andDocker repositories at https://github.com/softwareag and https://
hub.docker.com/u/softwareag and discover additional Software AG resources.

Product Support

Support for Software AG products is provided to licensed customers via our Empower Portal at
https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

Download products, updates and fixes.

Search the Knowledge Center for technical information and tips.

Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.
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Data Protection

SoftwareAGproducts provide functionalitywith respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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About the Adapter

Adapter for Apache Cassandra is an add-on to webMethods Integration Server that enables you
to interact with Apache Cassandra using DataStax java driver. Apache Cassandra is a distributed
NoSQL database management system designed to handle large amount of data across many
commodity servers, providing high availability with no single point of failure. Cassandra offers
robust support for clusters spanningmultiple datacenters,with asynchronousmasterless replication
allowing low latency operations for all clients.

UsingAdapter forApacheCassandra, you can create and run adapter services to performoperations
such as insert, update, delete and query data from a Cassandra table or Column Family.

Apache Cassandra Concepts

This section discusses the following concepts:

Keyspace
A keyspace is also called as a schema which is similar to a database or schema in RDBMS. It is the
unit for Cassandra's access control mechanism and also contains a set of tables.

Table
A table is known as a column family. It defines the column names and data types. Also, it is a map
of rows. The client application provides rows that conform to the schema. Each row has the same
fixed set of columns.

Rows
Cassandra supports tables defined with composite primary keys. The first column in a composite
key definition is used as the partition key. Remaining columns are automatically clustered. Rows
that share a partition key are sorted by the remaining components of the primary key.

Architecture and Components

Adapter for Apache Cassandra provides a set of user interfaces and services that enable you to
create integrationwithDatastax. The adapter is provided as a single package thatmust be installed
on Integration Server. For detailed installation instructions, see “Overview of installing and
uninstallingAdapter forApacheCassandra” on page 20. For software requirements, seewebMethods
Adapters System Requirements .

The following diagram shows at a high level, how the adapter components connect to Apache
Cassandra.
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webMethods Integration Server. Adapter for Apache Cassandra is installed and runs on
Integration Server.

(WmART). The WmART package provides a common framework for webMethods Adapter
for Apache Cassandra version 10.2 and later to use Integration Server's functionality, making
Integration Server the run-time environment for Adapter for Apache Cassandra. TheWmART
package is installed with Integration Server and it provides logging, error handling for the
adapter, connections, and services.

Adapter for Apache Cassandra. The Adapter for Apache Cassandra is delivered as a single
package calledWmCassandraAdapter. The adapter installation includes templates fromwhich
all adapter connections, and adapter services can be created. The adapter provides:

Integration Server Administrator user interfaces that will enable you to configure and
manage adapter connections

SoftwareAGDesigner user interfaces thatwill enable you to configure andmanage adapter
services

Adapter Service.Adapter services enable the Integration Server to initiate andperformdatabase
operations on Datastax. You configure adapter services using adapter services templates,
which are providedwith Adapter for Apache Cassandra. For more information about adapter
services, see “Overview of Adapter Services” on page 42.

Adapter Connection.Adapter connections enable the Integration Server to connect toDatastax
at runtime. You must configure an adapter connection before you can configure adapter
services. For a detailed description of adapter connections, see “Overview of Adapter for
Apache Cassandra Connections” on page 30.
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DataStax Cassandra Client API. DataStax Cassandra Client API is a client jar provided by
DataStax that connects to the Cassandra cluster .

ApacheCassandra.ApacheCassandra is a high-performance, extremely scalable, fault tolerant
(i.e., no single point of failure), distributed non-relational database solution. Cassandra combines
all the benefits of Google Bigtable and Amazon Dynamo to handle the type of database
management requirements that the traditional RDBMS vendors cannot support. DataStax is
the leading worldwide commercial provider of Cassandra products, services, support, and
training.

Package Management

Adapter for Apache Cassandra is available as a package called WmCassandraAdapter. You can
manage the WmCassandraAdapter package like any package on Integration Server.

You can set up andmanage the packages on Integration Server using the following considerations:

Create user-defined packages for your connections and adapter services. For details, see
“Adapter for Apache Cassandra Package Management” on page 24.

Understand how package dependencies work so that you can decide on how to manage your
adapter services. For details, see “Package Dependency Requirements and Guidelines” on
page 25.

Youmust have a control onwhich development groups have access to which adapter services.
For details, see “Group Access Control” on page 27.

Adapter Connections

Adapter for Apache Cassandra connects to DataStax throughClient jar API at run time. You create
one or more connections at design time to use in integrations.

Note:
Enabling or Disabling the connection will not have any effect as pooling is not supported by
the adapter.

For instructions on configuring Adapter for Apache Cassandra connections, see “Overview of
Adapter for Apache Cassandra Connections” on page 30. For information about setting user
privileges, see the webMethods Integration Server Administrator’s Guide for your release.

Built-In Services for Connections
Integration Server provides built-in services that enable you to programmatically control
connections. You can use them to enable and disable a connection, and to return usage statistics
and the current state (Enabled or Disabled) and error status for a connection. These services are
located in the WmART package, in the pub.art.connection folder.

The setAdapterServiceNodeConnection built-in service enables you to change the connection associated
with an adapter service respectively. Formore information, see “Change theConnectionAssociated
with an Adapter Service at Design Time” on page 15.
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For details, see the webMethods Integration Server Built-In Services Reference for your release.

Adapter Services

To use Adapter for Apache Cassandra, you create adapter services. Adapter services allow you
to connect to the adapter's resource and initiate an operation on the resource from Integration
Server

You call adapter services from flow or Java services to interact with . The adapter services perform
Cassandra table operations by callingDatastax Cassandra Client API. Integration Server then uses
adapter connections that you defined earlier to execute the adapter services. For details, see
“Adapter Service Processing” on page 15.

Adapter services are based on templates provided with Adapter for Apache Cassandra. Each
template represents a specific operation on a resource, such as using the Insert service template
to inserts specified information to the table.

An adapter service template contains all the code necessary for interacting with the resource but
without the data specifications. You provide these specifications when you create a new adapter
service.

Creating a new service from an adapter service template is straightforward. Using Software AG
Designer, you assign the service a default adapter connection.

After you select the connection for the adapter service, you select the adapter service template
and supply the data specifications usingDesigner. Some familiaritywith usingDesigner is required.
For more information, see the webMethods Service Development Help for your release.

Adapter for Apache Cassandra provides the following adapter service templates:

DescriptionAdapter Service
Template

Inserts the records into the table.Insert

For instructions about configuring the service, see “Configuring Insert
Service” on page 42 .

Updates the existing records in a table by updating the value of the column
anddeletes the existing value in the columnwithout removing the columns.

Update

For instructions about configuring the service, see “Configuring Update
Service” on page 50 .

Deletes the records from the table.Delete

For instructions about configuring the service, see “Configuring Delete
Service” on page 45.

Retrieves the records from the table.Query
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DescriptionAdapter Service
Template

For instructions about configuring the service, see “Configuring Query
Service” on page 55.

Retrieves records from the table using prepared statement.Query with Prepared
Statement

For instructions about configuring the service, see “Configuring Query
with Prepared Statement Service” on page 60.

Executes the configured CQL statement.CQL

For instructions about configuring the service, see “Configuring CQL
Service” on page 62.

Using Adapter Services
The following table lists the tasks required to use the adapter services.

Use these tools...For this task...

Integration Server Administrator1. Create an adapter connection. For details, see
“Overview of Adapter for Apache Cassandra
Connections” on page 30.

Designer2. Select the appropriate adapter service template and
configure the adapter service. Depending on the type
of adapter service, you specify:

The adapter connection

The input fields and types as needed

The output fields and types as needed

For more information about configuring adapter
services, see “Overview of Adapter Services” on
page 42.

Designer3.If you plan to use an Integration Server flow or Java
service to invoke the adapter service, design the flow
or Java service to use this adapter service.

Designer4. Manage the adapter service.

Integration Server
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Change the Connection Associated with an Adapter Service at
Design Time
Integration Server provides built-in services that you can use at design time to change the connection
associated with an adapter service. The built-in services are provided in the WmART package's
pub.art.service folder. Using the service setAdapterServiceNodeConnection, you can change the specific
connection associated with an adapter service at design time so that you need not create and
maintain multiple adapter services.

Note:
The setAdapterServiceNodeConnection can run at design time only. Do not use it within an Integration
Server flow or Java service. You must run the services directly from Designer by selecting a
service and running it.

For details, see the webMethods Integration Server Built-In Services Reference for your release.

Other built-in services enable you to control connections. For more information, see “Built-In
Services for Connections” on page 12.

Change the Connection Associated with an Adapter Service at
Run Time
Integration Server enables you to dynamically select the connection that a service uses to interact
with the adapter's resource. This feature enables one service to interact with multiple, and similar
backend resources.

For example, a service can be defined to use a default connection that interactswith your company's
production database. However, at run time you can override the default connection and instead
use another connection to interact with the company's test database.

Adapter Service Processing
The following diagram illustrates how Adapter for Apache Cassandra processes adapter services
at run time.
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DescriptionStep

An Integration Server client, typically using a flow or Java service, invokes a Adapter
forApacheCassandra service on Integration Server to perform an operation on aApache
Cassandra.

1

You configured the adapter service earlier using Designer.

The adapter service gets a connection from the service's connection pool.2

Adapter connections contain connection information of Apache Cassandra.

The adapter service uses the DataStax Cassandra Client API to connect to Apache
Cassandra.

3

All adapter services performs the CRUD operation against a data in Apache Cassandra.4

For Insert, Delete, Update, and Query services, the adapter service performs the
corresponding operation against the data in Apache Cassandra.

Depending on the adapter service type, such as a Query service, the adapter servicemay
return data to Integration Server.

5

If the operation is successful, the service returns the output from the Client jar API,
if applicable.

If the operation is unsuccessful, the service returns an error such as an Adapter
Exception. If theApacheCassandra throws an exceptionwhile performing the adapter
service's operation, the adapter logs the exception in the Integration Server log.

Viewing the Adapter's Update Level

You can view the list of updates that have been applied to the adapter. The list of updates appears
in the Updates field on the adapter's About page in Integration Server Administrator.
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Controlling Pagination

When using the adapter on Integration Server 10.1 and later, you can control the number of items
that are displayed on the adapter Connections screen. By default, 10 items are displayed per page.
Click Next and Previous to move through the pages, or click a page number to go directly to a
page.

To change the number of items displayed per page, set the watt.art.page.size property and specify
a different number of items.

To set the number of items per page

1. From Integration Server Administrator, click Settings>Extended .

2. Click Edit Extended Settings. In the Extended Settings editor, add or update the
watt.art.page.size property to specify the preferred number of items to display per page. For
example, to display 50 items per page, specify:

watt.art.page.size=50

3. Click Save Changes. The property appears in the Extended Settings list.

Formore information aboutworkingwith extended configuration settings, see thewebMethods
Integration Server Administrator’s Guide for your release.
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Overview of installing and uninstalling Adapter for Apache
Cassandra

This chapter explains how to install, anduninstallwebMethodsAdapter 10.2 forApacheCassandra.
The instructions use the Software AG Installer and Software AGUninstaller wizards. For complete
information about the wizards or other installation methods, or to install other webMethods
products, see the Installing webMethods Products On Premises for your release.

Requirements

For a list of operating systems, and webMethods products supported by Adapter for Apache
Cassandra, see webMethods Adapters System Requirements .

Adapter for ApacheCassandra has no hardware requirements beyond those of its host Integration
Server.

The Integration Server Home Directory

Beginningwith Integration Server 9.8, you can create and runmultiple Integration Server instances
under a single installation directory. Each Integration Server instance has a home directory under
Integration Server_directory \instances\instance_name that contains the packages, configuration
files, log files, and updates for the instance.

For more information about running multiple Integration Server instances, see the webMethods
Integration Server Administrator’s Guide for your release.

This guide uses the packages_directory as the home directory in Integration Server classpaths.
For Integration Server 9.8 and above, the packages_directory is Integration Server_directory
\instances\instance_name\packages directory.

Installing Adapter for Apache Cassandra

1. Download Installer from the Empower Product Support website.

2. If you are installing the adapter on an existing Integration Server, shut down the Integration
Server.

3. Start the Installer wizard.

4. Choose the webMethods release that includes the Integration Server on which you want to
install the adapter. For example, if you want to install the adapter on Integration Server 10.2,
choose the 10.2 release.

5. Specify the installation directory as follows:

If you are installing on an existing Integration Server, specify the webMethods installation
directory that contains the host Integration Server.
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If you are installing on an existing Integration Server and the adapter, specify the installation
directory to use.

6. In the product selection list, select Adapters > webMethods Adapter 10.2 for Apache
Cassandra.

If you are using Integration Server 10.1 and above, you can choose to install the package in
the default instance. In this case, Software AG Installer installs the adapter in both locations,
Integration Server_directory \packages and the default instance packages directory located in
Integration Server_directory \instances\default\packages.

7. To download the documentation for the adapter, go to Software AG Documentation website.

8. After the installation completes, close the Installer and start the host Integration Server.

Note:
Be sure that Apache Cassandra driver jars are installed while you are installing webMethods
Adapter for Apache Cassandra.

Uninstalling Adapter for Apache Cassandra

To uninstall Adapter for Apache Cassandra

1. Shut down the host Integration Server. You do not need to shut down any other webMethods
products or applications that are running on your machine.

2. Start Software AG Uninstaller, selecting the webMethods installation directory that contains
the host Integration Server.

3. In the product selection list, select Adapters > webMethods Adapter 10.2 for Apache
Cassandra. You can also choose to uninstall documentation.

4. After Uninstaller completes, restart the host Integration Server.

Note:
Uninstaller removes all Adapter for Apache Cassandra related files that were installed.
However, Uninstaller does not delete files created after you installed the adapter (for example,
user-created or configuration files), nor does it delete the adapter directory structure. You
can go to the Integration Server_directory \packages directory and Integration Server_directory
\instances\default\packages directory. Delete the WmCassandraAdapter directory.

webMethods Adapter for Apache Cassandra Installation and User’s Guide 10.2 21

2 Installing and Uninstalling Adapter for Apache Cassandra

http://documentation.softwareag.com


22 webMethods Adapter for Apache Cassandra Installation and User’s Guide 10.2

2 Installing and Uninstalling Adapter for Apache Cassandra



3 Package Management

■   Overview of Package Management ................................................................................ 24

■   Adapter for Apache Cassandra Package Management ................................................. 24

■   Group Access Control .................................................................................................... 27

webMethods Adapter for Apache Cassandra Installation and User’s Guide 10.2 23



Overview of Package Management

The following sections describe how to set up andmanage your webMethods Adapter for Apache
Cassandra packages and to set up Access Control Lists (ACLs).

Adapter for Apache Cassandra Package Management

Adapter for Apache Cassandra is provided as a package called WmCassandraAdapter. You can
manage the WmCassandraAdapter package as you would manage any package on webMethods
Integration Server.

When you create connections, and adapter services, define them in user-defined packages rather
than in theWmCassandraAdapter package. Doing so will allow you to manage the package more
easily.

As you create user-defined packages in which to store connections, and adapter services, use the
package management functionality provided in Software AG Designer and set the user-defined
packages to have a dependency on the WmCassandraAdapter package. That way, when the
WmCassandraAdapter package loads or reloads, the user-defined packages load automatically.
See the following diagram:

Package management tasks include:
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Setting package dependencies (see )

Package Dependency Requirements and Guidelines
This section contains a list of dependency requirements and guidelines for user-defined packages.
For instructions for setting package dependencies, see the webMethods Service Development Help
for your release.

A user-defined package must have a dependency on its associated adapter package,
WmCassandraAdapter. (TheWmCassandraAdapter packagehas adependencyon theWmART
package.)

Package dependencies ensure that at start-up the Integration Server automatically loads or
reloads all packages respectively: the WmART package, the adapter package, and the
user-defined packages. The WmART package is automatically installed when you install
Integration Server. You should manually reload the WmART package.

If the connections and adapter services of an adapter are defined in different packages, then:

A package that contains the connections must have a dependency on the adapter package.

Packages that contain adapter services must have a dependency on their associated
connection package.

Keep connections for different adapters in separate packages so that you do not create
interdependencies between adapters. If a package contains connections for two different
adapters, and you reload one of the adapter packages, the connections for both adapters will
reload automatically.

Integration Server will not allow you to enable a package if it has a dependency on another
package which is disabled. That is, before you can enable your package, you must enable all
packages on which your package depends. For information about enabling packages, see .

Integration Server will allow you to disable a package even if another package that is enabled
has a dependency on it. Therefore, youmust manually disable any user-defined packages that
have a dependency on the adapter package before you disable the adapter package. For
information about disabling packages, see .

You can provide same name for the connections, and adapter services, if they are in different
folders and packages.

Enabling Packages
All packages are automatically enabled by default. Use the following procedure when you want
to enable a package that was previously disabled.

To enable a package

1. Open Integration Server Administrator if it is not already open.
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2. In the Packages menu of the navigation area, click Management.

3. Click No in the Enabled column. The server displays Yes in the Enabled column.

Note:
Enabling an adapter package will not cause its associated user-defined packages to be
reloaded.

Important:
Before you manually enable a user-defined package, you must first enable its associated
adapter package (WmCassandraAdapter).

Disabling Packages
When you want to temporarily prohibit access to the elements in a package, disable the package.
When you disable a package, the server unloads all of its elements from memory. Disabling a
package prevents Integration Server from loading that package at startup.

Important:
If your adapter has multiple user-defined packages, and you want to disable some of them,
disable the adapter package (WmCassandraAdapter) first. Otherwise, errors will be issued
when you try to access the remaining enabled user-defined packages.

To disable a package

1. Open Integration Server Administrator if it is not already open.

2. In the Packages menu of the navigation area, click Management.

3. Click Yes in the Enabled column for the package that you want to disable. The server issues
a prompt to verify that you want to disable the package. Click OK to disable the package.
When the package is disabled, the server displays No in the Enabled column.

A disabled adapter will:

Remain disabled until you explicitly enable it using Integration Server Administrator.

Not be listed in Designer.

Importing and Exporting Packages
You can import and export packages using Designer. Exporting allows you to export the package
to a .zip file and save it to your hard drive. The .zip file can then be imported for use by another
package.

Important:
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Do not rename packages that you export; the rename function is comparable to moving a
package, andwhen you import the renamedpackage, you can lose any triggers, and connections,
associated with this package.

For details about importing and exporting packages, see the webMethods Service Development Help
for your release.

Group Access Control

To control which groups have access to which adapter services, use access control lists (ACLs).
For example, you can use ACLs to prevent one development group from inadvertently updating
the work of another group, or to allow or deny access to services that are restricted to one group
but not to others.

For information about assigning andmanagingACLs, see thewebMethods ServiceDevelopmentHelp
for your release.
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Overview of Adapter for Apache Cassandra Connections

This chapter describes how to configure andmanage Adapter for Apache Cassandra connections.
Formore information about howadapter connectionswork, see “Adapter Connections” on page 12.

Before Configuring or Managing Adapter Connection

Perform the following steps before configuring or managing adapter connections.

To prepare to configure or manage adapter connections

1. InstallwebMethods Integration Server andAdapter forApacheCassandra on the samemachine.
For details, see “Overview of installing and uninstalling Adapter for Apache Cassandra” on
page 20.

2. Make sure you have Integration Server administrator privileges so that you can access Adapter
for Apache Cassandra's administrative screens. For information about setting user privileges,
see the webMethods Integration Server Administrator’s Guide for your release.

3. Start your Integration Server and Integration Server Administrator, if they are not already
running.

4. Using Integration Server Administrator, make sure the WmCassandraAdapter package is
enabled. For instructions, see “Enabling Packages” on page 25.

5. Using Designer, create a user-defined package to contain the connection, if you have not done
so. Formore information aboutmanaging packages for the adapter, see “Overview of Package
Management” on page 24.

Configuring Adapter for Apache Cassandra Connection

When you configure Adapter for Apache Cassandra, you specify information that Integration
Server uses to connect to Apache Cassandra. You can configure Adapter for Apache Cassandra
connections manually using the Integration Server Administrator screen.

To configure an adapter connection

1. In theAdaptersmenuof Integration ServerAdministrator's navigation area, clickwebMethods
Adapter for Apache Cassandra.

2. On the Connections screen, click Configure New Connection.

3. On theConnectionTypes screen, clickApache Cassandra Connection to display theConfigure
Connection Type screen.
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4. In the webMethods Adapter for Apache Cassandra section, use the following fields:

Description/ActionField

The package in which to create the connection. You must create the
package using Designer before you can specify the package using this

Package

parameter. For general information about creating packages, see the
webMethods Service Development Help for your release.

Note:
Configure the connection in a user-defined package rather than in
the adapter's package. For other important considerations when
creating packages for Adapter for Apache Cassandra, see “Adapter
for Apache Cassandra Package Management” on page 24

Specifies the folder in which you create the connection.Folder Name

Specifies the name you want to give to the connection. Connection
names cannot have spaces or use special characters reserved by

Connection Name

Integration Server and Designer. For more information about the use
of special characters in package, folder, and element names, see the
webMethods Service Development Help for your release.

5. In the Connection Properties section, use the following fields:

Description/ActionField

The name of the client connection.Cluster Client Name

Note:

This client connection name is not the Cassandra cluster name,
but rather a name assigned to the Cassandra Client Connection.
You cannot createmultiple connectionswith sameClusterClient
Name.

Defines the points to which the list of Cassandra hosts connects. The
format is provided as follows:  host1:port1,host2:port2,….

Contact Point(s)

Note:
Be sure not to use the same cluster name in more than one
connection.

Enables the metrics for the connections.Enable Metrics

Enables the JMX reporting metrics for the connections.Enable JMX Metrics

Reads the pooling options from connection.properties file.Read Pooling
Options from Config
file
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Description/ActionField

Reads the protcol options from connection.properties file.Read Protocol
Options from Config
file

Reads the load balancing options from connection.properties file.Read Load balancing
Options from Config
file

Reads the policies options from connection.properties file.Read Policies from
Config file

Reads the socket options from connection.properties file.Read Socket Options
from Config file

Reads the query options from connection.properties file.Read Query Options
from Config file

For more information regarding the supported connection properties for Cassandra, see
“Supported Backed Connection Properties” on page 34

6. In the Connection Management Properties section, use the following fields:

Description/ActionField

Enables the connection to use connection pooling. For more
information about connectionpooling, see “AdapterConnections” on
page 12.

Enable Connection
Pooling

Note:
If you plan to enable connection pooling in a clustered
environment, consider the connection pool size.

If connection pooling is enabled, this field specifies the number of
connections to create when the connection is enabled. The adapter

Minimum Pool Size

will keep open the number of connections you configure here
regardless of whether these connections become idle.

If connection pooling is enabled, this field specifies the maximum
number of connections that can exist at one time in the connection
pool.

Maximum Pool Size

If connection pooling is enabled, this field specifies the number of
connections by which the pool will be incremented if connections
are needed, up to the maximum pool size.

Pool Increment Size

If connection pooling is enabled, this field specifies the number of
milliseconds that Integration Serverwill wait to obtain a connection

Block Timeout

before it times out and returns an error. For example, you have a
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Description/ActionField

poolwithMaximum Pool Size of 20. If you receive 30 simultaneous
requests for a connection, 10 requestswill bewaiting for a connection
from the pool. If you set the Block Timeout to 5000, the 10 requests
will wait for a connection for 5 seconds before they time out and
return an error. If the services using the connections require 10
seconds to complete and return connections to the pool, the pending
requests will fail and return an error message stating that no
connections are available. If you set the Block Timeout value too
high, you may encounter problems during error conditions. If a
request contains errors that delay the response, other requests will
not be sent. This setting should be tuned in conjunction with the
Maximum Pool Size to accommodate such bursts in processing.

If connection pooling is enabled, this field specifies the number of
milliseconds that an inactive connection can remain in the pool

Expire Timeout

before it is closed and removed from the pool. The connection pool
will remove inactive connections until the number of connections
in the pool is equal to the Minimum Pool Size. The inactivity timer
for a connection is reset when the connection is used by the adapter.

If you set the Expire Timeout value too high, you may have a
number of unused inactive connections in the pool. This consumes
local memory and a connection on your backend resource. This
could have an adverse effect if your resource has a limited number
of connections.

If you set the Expire Timeout value too low, performance could
degrade because of the increased activity of creating and closing
connections. This setting should be tuned in conjunction with the
Minimum Pool Size to avoid excessive opening/closing of
connections during normal processing.

The number of times that the system should attempt to initialize the
connection pool at startup if the initial attempt fails. The default is
0.

Startup Retry Count

The number of seconds that the system should wait between
attempts to initialize the connection pool.

Startup Backoff
Timeout

7. Click Save Connection.

The connection you created appears on the adapter's Connections screen and in Designer.

You can enable a connection only if the parameters for the connection are valid.

Note:

For connection pooling the Adapter for Apache Cassandra does not create these many
Cassandra client Objects even if you configure these options. Hence, the DataStax’s
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team recommends you to have only one Cassandra client Object per JVM as the
connection object is heavy.
If you need any different configuration settings for multiple Adapter for Apache
Cassandra connections, then you have to prepend the cluster name to respective
configuration properties in the connection.properties file. For example,
clustername.cassandra.codecRegistry.typecodecs = xxxxxxxxxxxxxxx.

Supported Backed Connection Properties

CodecRegistry

Action/DescriptionProperties

Configuration directory.cassandra.codecRegistry.typecodecs=

PoolinglOptions(Options related to connection pooling)

Action/DescriptionProperties

Sets the heart beat interval. Later, a message is
sent on an idle connection to make sure it is still
alive.

cassandra.poolingOptions.

hearbeatIntervalSeconds

Sets the timeout before an idle connection is
removed.

cassandra.poolingOptions.

idleTimeoutSeconds=

Sets the timeout when trying to acquire a
connection from a host's pool.

cassandra.poolingOptions.

poolTimeoutMillis=

Sets the core and maximum number of
connections per host with HostDistance set to
LOCAL in one call.

cassandra.poolingOptions.

coreConnectionsPerHost.local=

cassandra.poolingOptions.

maxConnectionsPerHost.local=

Sets the core and maximum number of
connections per host with HostDistance set to
REMOTE in one call.

cassandra.poolingOptions.

coreConnectionsPerHost.remote=#

cassandra.poolingOptions.

maxConnectionsPerHost.remote=
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ProtocolOptions(Options of the Cassandra native binary protocol)

Action/DescriptionProperties

Port to be used for binary protocol.cassandra.protocolOptions.port=

AuthProvider to be used for authentication against
the Cassandra nodes.

cassandra.protocolOptions.

authProvider=

Username for thecassandra.protocolOptions.

com.datastax.driver.core.username=

PlainTextAuthProvider.

Password for thecassandra.protocolOptions.

com.datastax.driver.core.password=

PlainTextAuthProvider.

Specify the implementation class of
com.datastax.driver.core.SSLOptions interface.

cassandra.protocolOptions.

sslOption=

Specify the protocol version. If the version is null,
then the biggest version supported by the first
node to which the driver connects to is used.

cassandra.protocolOptions.version=

Sets the compression to be used. By default, the
compression is not used.

cassandra.protocolOptions.

compression=

Specify the maximum wait time in seconds for
schema agreement before returning from a DDL
query.

cassandra.protocolOptions.

maxSchemaAgreement=

QueryOptions(Options related to defaults for individual queries)

Action/DescriptionProperties

Sets the default consistency level to use
queries.

cassandra.queryOptions.consistency=

Sets the default serial consistency level to use
queries.

cassandra.queryOptions.serialConsistency=

Sets the default fetch size value to use SELECT
queries.

cassandra.queryOptions.fetchSize=

Sets the default idempotence for queries.cassandra.queryOptions.idemPotence=
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Action/DescriptionProperties

Specifies if the client-side token and schema
metadata is to be enabled or not. By default,

cassandra.queryOptions.metadata=

this feature is enabled. Some applications
might want to disable it in order to eliminate
the overhead of querying the metadata and
building its client-side representation.

Sets the default window size in milliseconds,
which is used to debounce the node list
refresh requests.

cassandra.queryOptions.

maxPendingRefreshNodeListRequests=

The default window size inmilliseconds used
to debounce schema refresh requests.

cassandra.queryOptions.

maxPendingRefreshNodeRequests=

Sets themaximumnumber of schema refresh
requests that the control connection can
accumulate before executing them.

cassandra.queryOptions.

maxPendingRefreshSchemaRequests=

Sets the default window size in milliseconds
which is used to debounce the node list
refresh requests.

cassandra.queryOptions.

refreshNodeListIntervalMillis=

Sets the default window size in milliseconds
which is used to debounce node refresh
requests.

cassandra.queryOptions.

refreshNodeIntervalMillis=

Sets the maximum number of node refresh
requests that the control connection can
accumulate before executing them.

cassandra.queryOptions.

refreshSchemaIntervalMillis=

Specifywhether the driver should re-prepare
all cached prepared statements on a host

cassandra.queryOptions.reprepareOnUp=

when it marks it as back up. By default, this
feature is enabled.

Specify whether the driver should prepare
statements on all hosts in the cluster.

cassandra.queryOptions.prepareOnAllHosts=

SocketOptions( Options to configure low-level socket options for the connections
kept to the Cassandra hosts)

Action/DescriptionProperties

Sets the connection timeout in milliseconds.cassandra.socketOptions.

connectTimeoutMillis=

Sets the per-host read timeout in milliseconds.cassandra.socketOptions.
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Action/DescriptionProperties

readTimeoutMillis=

Specifies whether to enable reuse-address. It can be
either true or false.

cassandra.socketOptions.reuseAddress=

Specifies whether to enable TCP keepalive. It can be
either true or false.

cassandra.socketOptions.keepAlive=

Sets the linger-on-close timeout. By default, this
option is not set by the driver. The actual value is the

cassandra.socketOptions.soLinger=

default from the underlying Netty transport (Java
NIO or native epoll).

Specifies whether to disable Nagle's algorithm. By
default, this option is set to true (Nagle disabled).

cassandra.socketOptions.tcpNoDelay=

Sets a hint to the size of the underlying buffers for
incoming network Input/Output. The value given is
an integer value.

cassandra.socketOptions.receiveBufferSize=

Sets a hint to the size of the underlying buffers for
outgoing network Input/Output. The value given is
an integer value.

cassandra.socketOptions.sendBufferSize=

Policies(Policy that decides how often the reconnection to a dead node is attempted)

Action/DescriptionProperties

Type of ReconnectionPolicy eithercassandra.policies.reconnection.type=

com.datastax.driver.core.

policies.ConstantReconnectionPolicy

or

com.datastax.driver.core.

policies.ExponentialReconnectionPolicy.

The constant/base delay in milliseconds to be used
for this policy.

cassandra.policies.reconnection.delay=

The maximum delay in milliseconds between the
number of reconnecting attempts for this policy.

cassandra.policies.reconnection.

maxDelay=

Translates IP addresses received from Cassandra
nodes into locally queriable addresses. Specify the
implementation class of com.datastax.driver.core.

cassandra.policies.adresstranslator=
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Action/DescriptionProperties

policies.AddressTranslator.

A policy that defines a default behavior to adopt
when a request fails. Specify the implementation class
of

cassandra.policies.retry=

com.datastax.driver.core.policies.RetryPolicy.

Generates client-side, microsecond-precision query
timestamps. Specify the implementation class of

cassandra.policies.timestamp=

com.datastax.driver.core.TimestampGenerator.

The policy that decides if the driver will send
speculative queries to the next hostswhen the current
host takes too long to respond.

cassandra.policies.speculative=

The delay between each speculative execution. The
value must be strictly positive.

cassandra.policies.speculative.

const.DelayMillis=

The number of speculative executions. The valuemust
be an integer and strictly positive.

cassandra.policies.speculative.

const.maxExecutions=

The component that will record latencies. It will get
registeredwith the clusterwhen this policy initializes.

cassandra.policies.speculative.

percentile.tracker=

The percentile that a request's latency must fall into
is considered slow. For example, 99.0.

cassandra.policies.speculative.

percentile.percentile=

Themaximumnumber of speculative executions that
is triggered for a given request. The request does not

cassandra.policies.speculative.

percentile.maxExecutions= include the initial, normal requests. The Value must
be strictly positive.

The highest expected latency. If a higher value is
reported, it will be ignored and a warning will be
logged.

cassandra.policies.speculative.

percentile.

highestTrackableLatencyMillis=

Sets the number of significant decimal digits towhich
histograms maintains the value resolution and
separation.

cassandra.policies.speculative.

percentile.

numberOfSignificantValueDigits=

Sets the minimum number of values that is recorded
for a host before you consider the sample size
significant.

cassandra.policies.speculative.

percentile.minRecordedValues=
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Action/DescriptionProperties

Sets the time interval over which samples are
recorded.

cassandra.policies.speculative.

percentile.intervalMs=

Policies/LoadBalancing

Action/DescriptionProperties

The policy that decides the respective Cassandra hosts
to contact for each new query.

cassandra.policies.loadbalancing=

Specify implementation classes of

com.datastax.driver.core.policies.

LoadBalancingPolicy with comma separated.

com.datastax.driver.core.policies.DCAwareRoundRobinPolicy

Action/DescriptionProperties

Sets the name of the datacenter that is considered
"local" by the policy.

cassandra.policies.loadbalancing.

dcaware.localdc=

Sets the number of hosts per remote datacenter that
the policy should consider.

cassandra.policies.loadbalancing.

dcaware.hostPerRemoteDc=

Allows the policy to return remote hosts when
building query plans for queries having consistency
level LOCAL_ONE or LOCAL_QUORUM.

cassandra.policies.loadbalancing.

dcaware.allowhostPerRemote=

com.datastax.driver.core.policies.TokenAwarePolicy

Action/DescriptionProperties

Specifies whether to shuffle the replicas returned by
getRoutingKey. Note that setting this parameter to true

cassandra.policies.loadbalancing.

token.shufflereplicas= might decrease the effectiveness of caching (especially
at consistency level ONE), since the same row will be
retrieved from any replica (instead of only the "primary"
replica without shuffling). On the other hand, shuffling
will better distribute writes, and can alleviate hotspots
caused by "fat" partitions.
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com.datastax.driver.core.policies.WhiteListPolicy

Action/DescriptionProperties

Specify the white listed hosts.cassandra.policies.loadbalancing.

whilelist.addresses=

com.datastax.driver.core.policies.LatencyAwarePolicy

Action/DescriptionProperties

Sets the exclusion threshold to use for the resulting latency
aware policy.

cassandra.policies.loadbalancing.

latency.exclusionThreshold=

Sets the scale for the resulting latency aware policy.cassandra.policies.loadbalancing.

latency.scale=

Sets the retry period for the resulting latency aware policy.cassandra.policies.loadbalancing.

latency.retryPeriod=

Sets the minimum number of measurements per-host to
consider the resulting latency aware policy.

cassandra.policies.loadbalancing.

latency.minMeasure=

Sets the update rate for the resulting latency aware policy.cassandra.policies.loadbalancing.

latency.updateRate=

com.datastax.driver.core.policies.ErrorAwarePolicy

Action/DescriptionProperties

Defines the time duringwhich a host is excluded by the
policy once it has exceeded. By default, the value for
the retry period is 2 minutes.

cassandra.policies.loadbalancing.

error.retryPeriodNanos=

Defines the maximum number of errors allowed per
minute for each host. By default, the value for the
threshold is 1.

cassandra.policies.loadbalancing.

error.maxErrorPerMinute=
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Overview of Adapter Services

This chapter describes how to configure andmanage the services ofAdapter forApacheCassandra.
For detailed descriptions of the available Adapter for Apache Cassandra services, see “Adapter
Services” on page 13.

Before Managing Adapter Services

Perform the following steps before configuring or managing adapter services.

To prepare to configure or manage Adapter for Apache Cassandra services

1. Start the Integration Server and Integration Server Administrator, if they are not already
running.

2. Make sure you have administrator privileges to access the Adapter for Apache Cassandra
administrative screens. For information about setting user privileges, see the webMethods
Integration Server Administrator’s Guide for your release.

3. Using Integration Server Administrator, make sure the WmCassandraAdapter package is
enabled. For instructions, see “Enabling Packages” on page 25.

4. Using Integration Server Administrator, configure an adapter connection with the adapter
service. For instructions, see “Overview of Adapter for Apache Cassandra Connections” on
page 30.

Note:
Integration Server provides built-in services that you can use at design time to change the
connection associated with an adapter service. For more information, see “Change the
Connection Associated with an Adapter Service at Design Time” on page 15.

5. Start Designer if it is not already running.

6. Using Designer, create a user-defined package to contain the services, if you have not already
done so. When you configure adapter services, you must always define them in user-defined
packages rather than in the WmCassandraAdapter package. For more information about
managing packages for the adapter, see “Overview of Package Management” on page 24.

Configuring Insert Service

An Insert service inserts a new record into the table. You configure Insert service using Designer.
For more information about adapter services, see “Using Adapter Services” on page 14.

Read the section “Before Managing Adapter Services” on page 42, before you configure adapter
services.
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To configure an adapter service using the Insert template

1. In Designer, right-click the folder in which the service is to be contained and select New >
Adapter Service.

2. Select the parent namespace, type a name for the adapter service, and click Next.

3. Select webMethods Adapter for Apache Cassandra as the adapter type and click Next.

4. Select the appropriate Adapter Connection Name and click  Next.

5. From the list of available templates, select the Insert template and click Finish.

The adapter service editor for the selected adapter service appears. You can select theAdapter
Settings tab at any time to confirm Adapter Properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template as necessary.

6. Select the Table tab to configure the table and set the fields as follows:

Field Description/ActionField

Specifies the keyspace which is auto-populated based on the created
connection.

Keyspace Name

Specify the name of the table.Table Name

7. Use the Columns tab to provide values for the following fields:

a. Use the icon to populate a single column in the table. You can use the icon to display
all columns created in an existing table.

Description/ActionField

The column name in the table.Column Name

The column data type defined in the corresponding Column Name of
the table.

Column Type

Specifies the string representation of Column Type.Type Definition

The output field name.Input Field

The data type of the output field.Input Field Type

8. Use the Options tab to provide the appropriate values for the following fields:
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Description/ActionField

Defines to manage availability versus data accuracy. You can configure
consistency for a session or per individual read or write operation.

Consistency
Level

The write consistency levels in strongest-to-weakest order is given as
follows:

ALL: Provides the highest consistency and the lowest availability of
any other level.

EACH QUORIUM: Maintains a strict consistency level at the same level,
when used in multiple datacenter clusters.

QUORIUM: Maintains a strong consistency across the cluster, when used
in either single or multiple datacenter clusters. Use QUORIUM, if you
can tolerate some level of failure.

LOCAL QUORIUM: Maintains consistency locally. LOCAL QUORIUM is used
in multiple datacenter clusters with a rack-aware replica placement
strategy, such as (NetworkTopologyStatergy), and a properly
configured snitch. Can be used with SimpleStrategy.

LOCAL ONE: In a multiple datacenter clusters, the consistency level
cross-DC traffic is not desirable when compared to the consistency
level of ONE. LOCAL ONE accomplishes this. Use this consistency level
in an offline datacenter to prevent automatic connection to online
nodes in other datacenters if an offline node goes down.

THREE: Satisfies the needs of most users because consistency
requirements are not stringent.

ANY: Provides low latency and a guarantee that a write never fails.
Delivers the lowest consistency and highest availability.

The read consistency levels in strongest-to-weakest order is given as
follows:

ALL: Provides the highest consistency of all levels and the lowest
availability of all levels.

QUORIUM: Maintains strong consistency across the cluster, when used
in single or multiple datacenter clusters. Ensures strong consistency
if you can tolerate some level of failure.

LOCAL QUORIUM: Used inmultiple datacenter clusterswith a rack-aware
replica placement strategy (NetworkTopologyStrategy) and aproperly
configured snitch. Fails when used with SimpleStrategy.

THREE: Provides the highest availability of all the levels if you can
tolerate a comparatively high probability of stale data being read. The
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Description/ActionField

replicas contacted for reads may not always have the most recent
write.

LOCAL ONE: In a multiple datacenter clusters, the consistency level
cross-DC traffic is not desirable when compared to the consistency
level of ONE. LOCAL ONE accomplishes this. Use this consistency level
in an offline datacenter to prevent automatic connection to online
nodes in other datacenters if an offline node goes down.

SERIAL: Use SERIAL to read the latest value of a column after a user
has invoked a lightweight transaction to write to the column.
Cassandra then checks the inflight lightweight transaction for updates
and, if found, returns the latest data.

LOCAL SERIAL: Used to achieve linearizable consistency for lightweight
transactions.

Define to enable and disable the tracing for transactions on all nodes in
the cluster. Tracing is enabled to troubleshoot performance problems.

Enabling Tracing

Checks if there are any duplicates with same primary key column value.If Not Exists

9. To verify input or output information for the service, use the Input/Output tab as required.

The below fields are auto-populated in the input section of Input/Output tab:

Description/ActionField

Specify the time of insertion of the record.timestamp

Specifies the setting time for data in a column to expire. The value for the
field is accepted in milliseconds.

Time to live(ttl)

Note:
The remaining fields in the input section are auto-populated based on the columns selected
in Columns tab.

10. From the File menu, select Save.

Configuring Delete Service

A Delete service deletes the record from the Cassandra table. You configure Delete service using
Designer. For more information about adapter services, see “Using Adapter Services” on page 14.

Read the section “Before Managing Adapter Services” on page 42, before you configure adapter
services.
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To configure an adapter service using the Delete template

1. In Designer, right-click the folder in which the service is to be contained and select New >
Adapter Service.

2. Select the parent namespace, type a name for the adapter service, and click Next.

3. Select webMethods Adapter for Apache Cassandra as the adapter type and click Next.

4. Select the appropriate Adapter Connection Name and click  Next.

5. From the list of available templates, select the Delete template and click Finish.

The adapter service editor for the selected adapter service appears. You can select theAdapter
Settings tab at any time to confirm Adapter Properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template as necessary.

6. Select the Table tab to configure the table and set the fields as follows:

Field Description/ActionField

Specifies the keyspace which is auto-populated based on the created
connection.

Keyspace Name

Specify the name of the table.Table Name

7. Use the Columns tab to provide values for the following fields:

a. Use the icon to populate a single column in the table. You can use the icon to display
all columns created in an existing table.

Description/ActionField

The column name in the table.Column Name

The column data type defined in the corresponding Column Name of
the table.

Column Type

Specifies the string representation of Column Type.Type Definition

8. Use the Options tab to provide the appropriate values for the following fields:

Description/ActionField

Defines to manage availability versus data accuracy. You can configure
consistency for a session or per individual read or write operation.

Consistency
Level
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Description/ActionField

The write consistency levels in strongest-to-weakest order is given as
follows:

ALL: Provides the highest consistency and the lowest availability of
any other level.

EACH QUORIUM: Maintains a strict consistency level at the same level,
when used in multiple datacenter clusters.

QUORIUM: Maintains a strong consistency across the cluster, when used
in either single or multiple datacenter clusters. Use QUORIUM, if you
can tolerate some level of failure.

LOCAL QUORIUM: Maintains consistency locally. LOCAL QUORIUM is used
in multiple datacenter clusters with a rack-aware replica placement
strategy, such as (NetworkTopologyStatergy), and a properly
configured snitch. Can be used with SimpleStrategy.

LOCAL ONE: In a multiple datacenter clusters, the consistency level
cross-DC traffic is not desirable when compared to the consistency
level of ONE. LOCAL ONE accomplishes this. Use this consistency level
in an offline datacenter to prevent automatic connection to online
nodes in other datacenters if an offline node goes down.

THREE: Satisfies the needs of most users because consistency
requirements are not stringent.

ANY: Provides low latency and a guarantee that a write never fails.
Delivers the lowest consistency and highest availability.

The read consistency levels in strongest-to-weakest order is given as
follows:

ALL: Provides the highest consistency of all levels and the lowest
availability of all levels.

QUORIUM: Maintains strong consistency across the cluster, when used
in single or multiple datacenter clusters. Ensures strong consistency
if you can tolerate some level of failure.

LOCAL QUORIUM: Used inmultiple datacenter clusterswith a rack-aware
replica placement strategy (NetworkTopologyStrategy) and aproperly
configured snitch. Fails when used with SimpleStrategy.

THREE: Provides the highest availability of all the levels if you can
tolerate a comparatively high probability of stale data being read. The
replicas contacted for reads may not always have the most recent
write.
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LOCAL ONE: In a multiple datacenter clusters, the consistency level
cross-DC traffic is not desirable when compared to the consistency
level of ONE. LOCAL ONE accomplishes this. Use this consistency level
in an offline datacenter to prevent automatic connection to online
nodes in other datacenters if an offline node goes down.

SERIAL: Use SERIAL to read the latest value of a column after a user
has invoked a lightweight transaction to write to the column.
Cassandra then checks the inflight lightweight transaction for updates
and, if found, returns the latest data.

LOCAL SERIAL: Used to achieve linearizable consistency for lightweight
transactions.

Define to enable and disable the tracing for transactions on all nodes in
the cluster. Tracing is enabled to troubleshoot performance problems.

EnableTracing

Checks if columns value selected inWHERE clause is available anddeletes
the record and returns the success value as true else returns the value as
false.

If Exists

9. Use the WHERE tab to specify the conditions for selecting information:

a. Select the icon to define the newWHERE clause fields.

b. Select the AND logical operator and specify the following fields:

Name Description/ActionField

The logical operator.AND

The name of the column you want to use in the WHERE clause.Column

The following are the operators used:Operator

=

IN

The default value is ?, which acts as a placeholder for the variable so that
you can set the input variable for that column at run time, or get input

Input Field

external to this adapter service. You can also type a fixed value in this field
now or at run time. If you type a fixed value, be sure that it is valid, or an
exception will be generated at run time.

The adapter automatically generates values for the following fields:
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The unique key for those rows in the above table which takes input at
runtime.

Parameter

The name of the column you need to use in the WHERE clause.Column

The CQL data type defined in the corresponding Column Name of
the table.

CQL Type

The corresponding data type of the  Input Field.Input Field Type

The name of the input field. By default the name combines the values
of Parameter and Column fields. However, you can also choose to
specify any custom value.

Input Field

10. Use the If Clause tab to specify the if condition for the following:

a. Select the icon to define the new If Clause fields.

b. Select the AND logical operator and specify the following fields:

Name Description/ActionName

The logical operator.AND

The name of the column you want to use in the If Clause.Column

The following are the operators used:Operator

=

<

>

<=

>=

IN

CONTAINS

CONTAINS KEY

The default value is ?, which acts as a placeholder for the variable so that
you can set the input variable for that column at run time, or get input

Input Field

external to this adapter service. You can also type a fixed value in this field
now or at run time. If you type a fixed value, be sure that it is valid, or an
exception will be generated at run time.
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The adapter automatically generates values for the following fields:

Description/ActionField

The unique key for those rows in the above table which takes input at
runtime.

Parameter

The name of the column you need to use in the WHERE clause.Column

The CQL data type defined in the corresponding Column Name of
the table.

CQL Type

The corresponding data type of the  Input Field.Input Field Type

The name of the input field. By default the name combines the values
of Parameter and Column fields. However, you can also choose to
specify any custom value.

Input Field

Note:
If Not Exists field cannot be used with If Clause tab at the same time.

11. To verify input or output information for the service, use the Input/Output tab as required.

The below field is auto-populated in input section of Input/Output tab:

Description/ActionField

Specify the time of insertion of the record.timestamp

Note:
The remaining fields in the input section are auto-populated based on the columns selected
inWHERE tab and If Clause tab.

The below field is populated in the output section of Input/Output tab:

Description/ActionField

Specifies the result of the service. It can either be true or false.success

12. From the File menu, select Save.

Configuring Update Service

A Update service updates the existing record. You configure Update service using Designer. For
more information about adapter services, see “Using Adapter Services” on page 14.

Read the section “Before Managing Adapter Services” on page 42, before you configure adapter
services.
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To configure an adapter service using the Update template

1. In Designer, right-click the folder in which the service is to be contained and select New >
Adapter Service.

2. Select the parent namespace, type a name for the adapter service, and click Next.

3. Select webMethods Adapter for Apache Cassandra as the adapter type and click Next.

4. Select the appropriate Adapter Connection Name and click  Next.

5. From the list of available templates, select the Update template and click Finish.

The adapter service editor for the selected adapter service appears. You can select theAdapter
Settings tab at any time to confirm Adapter Properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template as necessary.

6. Select the Table tab to configure the table and set the fields as follows:

Field Description/ActionField

Specifies the keyspace which is auto-populated based on the created
connection.

Keyspace Name

Specify the name of the table.Table Name

7. Use the Columns tab to provide values for the following fields:

a. Use the icon to populate a single column in the table. You can use the icon to display
all columns created in an existing table.

Description/ActionField

The column name in the table.Column Name

The column data type defined in the corresponding Column Name of
the table.

Column Type

Specifies the string representation of Column Type.Type Definition

The input field name.Input Field

The data type of the input field.Input Field Type

8. Use the Options tab to provide the appropriate values for the following fields:
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Defines to manage availability versus data accuracy. You can configure
consistency for a session or per individual read or write operation.

Consistency
Level

The write consistency levels in strongest-to-weakest order is given as
follows:

ALL: Provides the highest consistency and the lowest availability of
any other level.

EACH QUORIUM: Maintains a strict consistency level at the same level,
when used in multiple datacenter clusters.

QUORIUM: Maintains a strong consistency across the cluster, when used
in either single or multiple datacenter clusters. Use QUORIUM, if you
can tolerate some level of failure.

LOCAL QUORIUM: Maintains consistency locally. LOCAL QUORIUM is used
in multiple datacenter clusters with a rack-aware replica placement
strategy, such as (NetworkTopologyStatergy), and a properly
configured snitch. Can be used with SimpleStrategy.

LOCAL ONE: In a multiple datacenter clusters, the consistency level
cross-DC traffic is not desirable when compared to the consistency
level of ONE. LOCAL ONE accomplishes this. Use this consistency level
in an offline datacenter to prevent automatic connection to online
nodes in other datacenters if an offline node goes down.

THREE: Satisfies the needs of most users because consistency
requirements are not stringent.

ANY: Provides low latency and a guarantee that a write never fails.
Delivers the lowest consistency and highest availability.

The read consistency levels in strongest-to-weakest order is given as
follows:

ALL: Provides the highest consistency of all levels and the lowest
availability of all levels.

QUORIUM: Maintains strong consistency across the cluster, when used
in single or multiple datacenter clusters. Ensures strong consistency
if you can tolerate some level of failure.

LOCAL QUORIUM: Used inmultiple datacenter clusterswith a rack-aware
replica placement strategy (NetworkTopologyStrategy) and aproperly
configured snitch. Fails when used with SimpleStrategy.

THREE: Provides the highest availability of all the levels if you can
tolerate a comparatively high probability of stale data being read. The
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replicas contacted for reads may not always have the most recent
write.

LOCAL ONE: In a multiple datacenter clusters, the consistency level
cross-DC traffic is not desirable when compared to the consistency
level of ONE. LOCAL ONE accomplishes this. Use this consistency level
in an offline datacenter to prevent automatic connection to online
nodes in other datacenters if an offline node goes down.

SERIAL: Use SERIAL to read the latest value of a column after a user
has invoked a lightweight transaction to write to the column.
Cassandra then checks the inflight lightweight transaction for updates
and, if found, returns the latest data.

LOCAL SERIAL: Used to achieve linearizable consistency for lightweight
transactions.

Define to enable and disable the tracing for transactions on all nodes in
the cluster. Tracing is enabled to troubleshoot performance problems.

Enabling Tracing

Checks if there are any duplicates with same column value.If Exists

9. Use the WHERE tab to specify the valid conditions for selecting information:

a. Select the icon to define the newWHERE clause fields.

b. Select the AND logical operator and specify the following fields:

Name Description/ActionName

The logical operator.AND

The name of the column you want to use in the WHERE clause.Column

The following are the operators used:Operator

=

IN

The default value is ?, which acts as a placeholder for the variable so that
you can set the input variable for that column at run time, or get input

Input Field

external to this adapter service. You can also type a fixed value in this field
now or at run time. If you type a fixed value, be sure that it is valid, or an
exception will be generated at run time.

The adapter automatically generates values for the following fields:
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The unique key for those rows in the above table which takes input at
runtime.

Parameter

The name of the column you need to use in the WHERE clause.Column

The CQL data type defined in the corresponding Column Name of
the table.

CQL Type

The corresponding data type of the  Input Field.Input Field Type

The name of the input field. By default the name combines the values
of Parameter and Column fields. However, you can also choose to
specify any custom value.

Input Field

10. Use the If Clause tab to specify the if condition for the following:

a. Select the icon to define the new If Clause fields.

b. Select the AND logical operator and specify the following fields:

Name Description/ActionName

The logical operator.AND

The name of the column you want to use in the WHERE clause.Column

The following are the operators used:Operator

=

<

>

<=

>=

IN

CONTAINS

CONTAINS KEY

The default value is ?, which acts as a placeholder for the variable so that
you can set the input variable for that column at run time, or get input

Input Field

external to this adapter service. You can also type a fixed value in this field
now or at run time. If you type a fixed value, be sure that it is valid, or an
exception will be generated at run time.
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The adapter automatically generates values for the following fields:

Description/ActionField

The unique key for those rows in the above table which takes input at
runtime.

Parameter

The name of the column you need to use in the WHERE clause.Column

The CQL data type defined in the corresponding Column Name of
the table.

CQL Type

The corresponding data type of the  Input Field.Input Field Type

The name of the input field. By default the name combines the values
of Parameter and Column fields. However, you can also choose to
specify any custom value.

Input Field

11. To verify input or output information for the service, use the Input/Output tab as required.

The below fields are auto-populated in the input section of Input/Output tab:

Description/ActionField

Specify the time of insertion of the record.timestamp

Specifies the setting time for data in a column to expire. The value for the
field is accepted in milliseconds.

Time to live(ttl)

Note:
The remaining fields in the input section are auto-populated based on the columns selected
in Columns,WHERE, and If Clause tabs.

12. From the File menu, select Save.

Configuring Query Service

AQuery service retrieves the record from the Cassandra table. You configure Query service using
Designer. For more information about adapter services, see “Using Adapter Services” on page 14.

Read the section “Before Managing Adapter Services” on page 42, before you configure adapter
services.

To configure an adapter service using the Query template

1. In Designer, right-click the folder in which the service is to be contained and select New >
Adapter Service.
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2. Select the parent namespace, type a name for the adapter service, and click Next.

3. Select webMethods Adapter for Apache Cassandra as the adapter type and click Next.

4. Select the appropriate Adapter Connection Name and click  Next.

5. From the list of available templates, select the Query template and click Finish.

The adapter service editor for the selected adapter service appears. You can select theAdapter
Settings tab at any time to confirm Adapter Properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template as necessary.

6. Select the Table tab to configure the table and set the fields as follows:

Field Description/ActionField

Specifies the keyspace which is auto-populated based on the created
connection.

Keyspace Name

Specify the name of the table.Table Name

7. Use the Columns tab to provide values for the following fields:

a. Use the icon to populate a single column in the table. You can use the icon to display
all columns created in an existing table.

Description/ActionField

The column name in the table.Column Name

The column data type defined in the corresponding Column Name of
the table.

Column Type

Specifies the string representation of Column Type.Type Definition

The output field name.Output Field

The Java type that corresponds to the output field.Output Field
Type

8. Use the Options tab to provide the appropriate values for the following fields:

Description/ActionField

Limits the number of records for a table, if the records exceeds by the
given size. The default value is -1.

Fetch Size
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Provides the capability to query the clustering columns using any
condition.

Allow Filtering

Defines to manage availability versus data accuracy. You can configure
consistency for a session or per individual read or write operation.

Consistency
Level

The write consistency levels in strongest-to-weakest order is given as
follows:

ALL: Provides the highest consistency and the lowest availability of
any other level.

EACH QUORIUM: Maintains a strict consistency level at the same level,
when used in multiple datacenter clusters.

QUORIUM: Maintains a strong consistency across the cluster, when used
in either single or multiple datacenter clusters. Use QUORIUM, if you
can tolerate some level of failure.

LOCAL QUORIUM: Maintains consistency locally. LOCAL QUORIUM is used
in multiple datacenter clusters with a rack-aware replica placement
strategy, such as (NetworkTopologyStatergy), and a properly
configured snitch. Can be used with SimpleStrategy.

LOCAL ONE: In a multiple datacenter clusters, the consistency level
cross-DC traffic is not desirable when compared to the consistency
level of ONE. LOCAL ONE accomplishes this. Use this consistency level
in an offline datacenter to prevent automatic connection to online
nodes in other datacenters if an offline node goes down.

THREE: Satisfies the needs of most users because consistency
requirements are not stringent.

ANY: Provides low latency and a guarantee that a write never fails.
Delivers the lowest consistency and highest availability.

The read consistency levels in strongest-to-weakest order is given as
follows:

ALL: Provides the highest consistency of all levels and the lowest
availability of all levels.

QUORIUM: Maintains strong consistency across the cluster, when used
in single or multiple datacenter clusters. Ensures strong consistency
if you can tolerate some level of failure.

LOCAL QUORIUM: Used inmultiple datacenter clusterswith a rack-aware
replica placement strategy (NetworkTopologyStrategy) and aproperly
configured snitch. Fails when used with SimpleStrategy.
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THREE: Provides the highest availability of all the levels if you can
tolerate a comparatively high probability of stale data being read. The
replicas contacted for reads may not always have the most recent
write.

LOCAL ONE: In a multiple datacenter clusters, the consistency level
cross-DC traffic is not desirable when compared to the consistency
level of ONE. LOCAL ONE accomplishes this. Use this consistency level
in an offline datacenter to prevent automatic connection to online
nodes in other datacenters if an offline node goes down.

SERIAL: Use SERIAL to read the latest value of a column after a user
has invoked a lightweight transaction to write to the column.
Cassandra then checks the inflight lightweight transaction for updates
and, if found, returns the latest data.

LOCAL SERIAL: Used to achieve linearizable consistency for lightweight
transactions.

Limits the number of records to be retrieved by providing a definite value.Limit

Specify the read time out value in milli seconds. This value is the amount
of time Adapter for Apache Cassandra waits for the response from the
Cassandra node to execute before stopping the Query service.

Read Timeout in
Millis

Define to enable and disable the tracing for transactions on all nodes in
the cluster. Tracing is enabled to troubleshoot performance problems.

Enabling Tracing

9. Use the WHERE tab to specify the valid conditions for selecting information:

a. Select the icon to define the newWHERE clause fields.

b. Select the AND logical operator and specify the following fields:

Name Description/ActionName

The logical operator.AND

The name of the column you want to use in the WHERE clause.Column

The following are the operators used:Operator

=

<

>

<=
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Name Description/ActionName

>=

IN

CONTAINS

CONTAINS KEY

The default value is ?, which acts as a placeholder for the variable so that
you can set the input variable for that column at run time, or get input

Input Field

external to this adapter service. You can also type a fixed value in this field
now or at run time. If you type a fixed value, be sure that it is valid, or an
exception will be generated at run time.

The adapter automatically generates values for the following fields:

Description/ActionField

The unique key for those rows in the above table which takes input at
runtime.

Parameter

The name of the column you need to use in the WHERE clause.Column

The CQL data type defined in the corresponding Column Name of
the table.

CQL Type

The corresponding data type of the  Input Field.Input Field Type

The name of the input field. By default the name combines the values
of Parameter and Column fields. However, you can also choose to
specify any custom value.

Input Field

10. Use the OrderBy tab to define the values for the following fields:

Description/ActionField

Displays the columns which contains only the cluster key type.Column Name

Displays the records in correct ascending or descending order. Select
either ASC orDES. By default, ASC is selected.

Sort Order

11. To verify input or output information for the service, use the Input/Output tab as required.

Here, the columns selected in WHERE tab is auto-populated.

12. From the File menu, select Save.
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Configuring Query with Prepared Statement Service

A Query with Prepared Statement service retrieves the record from the Cassandra table using a
prepared statement. You configure Query with Prepared Statement service using Designer. For
more information about adapter services, see “Using Adapter Services” on page 14.

Read the section “Before Managing Adapter Services” on page 42, before you configure adapter
services.

To configure an adapter service using the Delete template

1. In Designer, right-click the folder in which the service is to be contained and select New >
Adapter Service.

2. Select the parent namespace, type a name for the adapter service, and click Next.

3. Select webMethods Adapter for Apache Cassandra as the adapter type and click Next.

4. Select the appropriate Adapter Connection Name and click  Next.

5. From the list of available templates, select the Query with Prepared Statement template and
click Finish.

The adapter service editor for the selected adapter service appears. You can select theAdapter
Settings tab at any time to confirm Adapter Properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template as necessary.

6. Select the Table tab to configure the table and set the fields as follows:

Field Description/ActionField

Specifies the keyspace which is auto-populated based on the created
connection.

Keyspace Name

Specify the name of the table.Table Name

7. Use the Columns tab to provide values for the following fields:

a. Use the icon to populate a single column in the table. You can use the icon to display
all columns created in an existing table.

Description/ActionField

The column name in the table.Column Name

The column data type defined in the corresponding Column Name of
the table.

Column Type

60 webMethods Adapter for Apache Cassandra Installation and User’s Guide 10.2

5 Adapter Services



Description/ActionField

Specifies the string representation of Column Type.Type Definition

The output field name.Output Field

The Java type that corresponds to the output field.Output Field
Type

8. Use the Options tab to provide the appropriate values for the following fields:

Description/ActionField

Provides the capability to query the clustering columns using any
condition.

Allow Filtering

Limits the number of records to be retrieved by providing a definite value.Limit

9. Use the WHERE tab to specify the valid conditions for selecting information:

a. Select the icon to define the newWHERE clause fields.

b. Select the AND logical operator and specify the following fields:

Name Description/ActionName

The logical operator.AND

The name of the column you want to use in the WHERE clause.Column

The following are the operators used:Operator

=

<

>

<=

>=

IN

CONTAINS

CONTAINS KEY

The default value is ?, which acts as a placeholder for the variable so that
you can set the input variable for that column at run time, or get input

Input Field

external to this adapter service. You can also type a fixed value in this field
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Name Description/ActionName

now or at run time. If you type a fixed value, be sure that it is valid, or an
exception will be generated at run time.

The adapter automatically generates values for the following fields:

Description/ActionField

The unique key for those rows in the above table which takes input at
runtime.

Parameter

The name of the column you need to use in the WHERE clause.Column

The CQL data type defined in the corresponding Column Name of
the table.

CQL Type

The corresponding data type of the  Input Field.Input Field Type

The name of the input field. By default the name combines the values
of Parameter and Column fields. However, you can also choose to
specify any custom value.

Input Field

Note:
If Not Exists field cannot be used with If Clause field at the same time.

10. Use the Orderby tab to define the values for the following fields:

Description/ActionField

Displays the columns which contains only the cluster key type.Column Name

Displays the records in correct ascending or descending order. Select
either ASC orDES. By default, ASC is selected.

Sort Order

11. To verify input or output information for the service, use the Input/Output tab as required.

Here, the columns selected in WHERE tab is auto-populated.

12. From the File menu, select Save.

Configuring CQL Service

A CQL Statement service executes the configured CQL statements. You configure CQL service
using Designer. For more information about adapter services, see , “Using Adapter Services” on
page 14.

Read the section “Before Managing Adapter Services” on page 42, before you configure adapter
services.
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To configure an adapter service using the CQL template

1. In Designer, right-click the folder in which the service is to be contained and select New >
Adapter Service.

2. Select the parent namespace, type a name for the adapter service, and click Next.

3. Select webMethods Adapter for Apache Cassandra as the adapter type and click Next.

4. Select the appropriate Adapter Connection Name and click  Next.

5. From the list of available templates, select the CQL template and click Finish.

The adapter service editor for the selected adapter service appears. You can select theAdapter
Settings tab at any time to confirm Adapter Properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template as necessary.

6. Use the CQL tab to specify the If condition for the following fields:

a. Select the icon to define the new If Clause fields.

Name Description/ActionName

Specify the input field name.Input Field Name

Select the Input CQL Type of the input field.Input CQL Type

The Java type that corresponds to the input CQL type.Input Field Type

The adapter automatically generates values for the following fields:

Description/ActionField

The name of any output parameters of the CQL statement.Output Column
Name

The output parameter of CQL type.Output CQL Type

The Java type that corresponds to the Output CQL Type.Output Column Type

7. To verify input or output information for the service, use the Input/Output tab as required.

Here, the columns selected in the Input Field Name of CQL tab is auto-populated.

8. From the File menu, select Save.
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6 Predefined Health Indicator

■   Predefined Health Indicator ............................................................................................ 66
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Predefined Health Indicator

Microservices Runtime includes predefined health indicators for some of its basic components.
The health indicator captures the connection details for all theWmARTbased adapters at runtime.
For more information, see webMethods Adapter Runtime User's Guide.
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7 Administrator APIs

■   Administrator APIs .......................................................................................................... 68
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Administrator APIs

The Administrator APIs are available for Adapter for Apache Cassandra. For more information
about Administrator APIs and samples, see webMethods Adapter Runtime User's Guide.
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Configuration Variables Templates for Adapter Assets in
Microservices Runtime

ThewebMethodsAdapter Runtime (ART) asset properties that can be configured from Integration
ServerAdministrator are available in the configuration variables template (application.properties
file) generated by Microservices Runtime. For more information, see webMethods Adapter Runtime
User's Guide and Developing Microservices with webMethods Microservices Runtime.
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SQL Data Type to JDBC Data Type Mappings

webMethods Adapter for Apache Cassandra's maps CQL or column type to respective java type
as shown in the below table. Adapter for Apache Cassandra expects inputs in its respective java
typewhile inserting or updating values for collection or tuple data types. Also, use the below data
types for IN operator of WHERE clause.

Java Data TypeColumn Type/CQL Type

java.lang.StringASCII

java.lang.LongBIGINT

byte [ ]BLOB

java.lang.BooleanBOOLEAN

java.lang.LongCOUNTER

java.util.DateDATE

java.math.BigDecimalDECIMAL

java.lang.DoubleDOUBLE

java.lang.FloatFLOAT

java.net.InetAddressINET

java.lang.IntegerINT

java.util.ListLIST

java.util.MapMAP

java.util.SetSET

java.lang.ShortSMALLINT

java.lang.StringsTEXT

java.lang.LongTIME

java.lang.LongTIMESTAMP

java.util.UUIDTIMEUUID

java.lang.ByteTINYINT

Object[]TUPLE

com.wm.data.IDataUDT

java.util.UUIDUUID
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Java Data TypeColumn Type/CQL Type

java.lang.StringVARCHAR

java.math.BigIntegerVARINT

Note:
Be sure to pass java.nio.ByteBuffer type values in Object array, only for theWHERE clause with
IN operator in BLOB data type.

User Defined Types

webMethods Adapter for Apache Cassandra handles user-defined data type as IData document
types. Hence, in the Adapter service templates, input type or output type for UDT column type
is considered as a document(com.wm.data.IData).
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